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Using WinGauge

WinGauge is a dynamic reporting tool that constantly monitors your use of Windows and your
applications, to alert you to potential problems before they become serious. Information about your
system is displayed to you in the form of gauges. You select what to monitor, which type of gauge to use
and, more importantly, when you want notification that your specified limits have been reached.

You can choose to have one, a few or many gauges active at any one time-with each gauge reporting on
the status of your system. The more advanced you are, or the more demanding your projects, the more
gauges you may want to keep active to monitor particular aspects of your computer and applications.

By using WinGauge, and by customizing the gauges to your own specific needs, you will be warned
about potential problems well in time to take the necessary preventative steps. WinGauge alerts you so
that you can, for example, save your data, close programs or take other actions to prevent your system
from slowing down, crashing, or locking-up. As an added bonus, you can also drag application icons and
folders into WinGauge, so that WinGauge becomes your one-stop system monitoring and application
launch pad.

The Most Important Gauges
The following short list summarizes the gauges that are the most important to have active, and outlines
what they measure:

] Highest Resources-The Highest Resources gauge measures "system resources"-small, critical
memory regions in Windows itself. When any of these regions fill up, your system may crash. You can
increase your resources by closing some applications.

o Virtual Memory-The Virtual Memory gauge measures how much of your disk swap file is in use.
The more of your swap file you use, the slower your system will run. If your swap file fills up, your system
may crash. If you find that your virtual memory is frequently high, you should consider buying and
installing more RAM and making more room available on your Windows drive.

m] Swap File Requests-The Swap File Requests gauge measures how often Windows is accessing
the swap file. The more frequent the accesses, the less efficient is your overall system.
] Drive Space-The Drive Space gauge measures how much room is left on your drives. If a disk

fills up while a program is running, your system might crash.
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Starting WinGauge

WinGauge is a dynamic reporting tool that tracks Windows applications and alerts you to potential
problems so you can avoid them.

You can start WinGauge at any time, and keep it running (in the background or as the topmost window)
during your Windows session. For details about making WinGauge the topmost window, see Making

WinGauge the Topmost Window.

To start WinGauge in Windows 95:
1. Click the Start button on the taskbar.

2. Choose the WinGauge command from the Start > Programs > Nuts & Bolts menu.
The WinGauge window appears.

To start WinGauge in Windows 3.1x:
1. Double-click the Nuts & Bolts program group in the Program Manager window.

2. Double-click the WinGaugegram icon.

The WinGauge window appears.

Related Topics
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Auto-Starting WinGauge
You can set up WinGauge to start automatically whenever you turn on or restart your computer.
To auto-start WinGauge in Windows 95:
1. Click the Start button on the taskbar.
2. Choose the Taskbar command from the Settings menu.
The Taskbar Properties dialog box appears.
Select the Start Menu Programs tab to bring it to the front.
Click the Add button.

5. Do one of the following:

Enter the path where WinGauge is located.
The default path is:
C:\PROGRAM FILES\HELIX SOFTWARE\NUTS & BOLTS

Click the Browse button, and open the WinGauge folder.
Select the WINGAUGE.EXE file and click Open.

Click the Next > button.

Select the Startup folder and click the Next > button.

Click the Finish button. Then click OK.

The next time you restart your computer, WinGauge starts automatically.

To auto-start WinGauge in Windows 3.1x:
1. Open the WinGaugegram group.

2. Drag the WinGaugegram icon to the Startup program group.
The next time you restart your computer, WinGauge starts automatically.



Manipulating the WinGauge Window

You can interactively change the appearance or change the behavior of the WinGauge window as
described in these help topics:

Resizing the WinGauge Window

Resizing Gauges in the WinGauge Window
Rearranging Gauges in the WinGauge Window
Making WinGauge the Topmost Window
Docking/Undocking the WinGauge Window
Enabling/Disabling the Auto Hide Feature

Showing/Hiding the WinGauge Window

Showing/Hiding the WinGauge Titlebar



Resizing the WinGauge Window

While the WinGauge window is undocked, you can interactively resize the window by dragging its sides
or corners to a new location.

As you resize the WinGauge window, the gauges that are visible stay the same size, and in the same
sequential order (from left to right and downward). However, the number of rows and columns of gauges
changes to fit into the new rectangular shape of the window.

To resize the WinGauge window:
1. Point to any corner or side of the WinGauge window.

The pointer changes to a horizontal, vertical, or diagonal double-tipped Arrow pointer.
2. Drag the window edge in any direction to a new location.

As you resize the window, the gauges stay the same size and in the same order, but the number of
rows and columns changes



Resizing Gauges in the WinGauge Window

While the WinGauge window is undocked, you can interactively resize all gauges in the window by Cirl-
dragging the sides or corners of the WinGauge window to a new location. You can also resize all gauges
in the Properties sheet's Global tab as described in Changing All Gauges' Global Properties.

As you resize the gauges, they stay in the same sequential order (from left to right and downward). Also,
the number of rows and columns of gauges stays the same.
To resize gauges in the WinGauge window:
1. Point to any corner or side of the WinGauge window.
The pointer changes to a horizontal, vertical, or diagonal double-tipped Arrow pointer.
2. Hold down the Ctrl key and drag the side of the window in any direction to a new location.

As you resize the window, the gauges stay in the same sequential order but their size uniformly
changes



Rearranging Gauges in the WinGauge Window

Tip You must have the titlebar visible in order to rearrange gauges.
You can drag gauges around in the gauge area to move them to a new location in the WinGauge window.
You might do this to place related gauges in adjacent positions. If you do this, you may also want to
change the borders of the adjacent gauges to group them. For details, see Changing a Gauge's

Appearance.



Getting Bubble Help
Point to a gauge and wait the specified number of seconds to see Bubble help for that gauge.

Tip You can turn Bubble help on or off, or change the delay (in seconds) after which Bubble help
appears. You make these selections in the Global tab of the Properties sheet. For details, see

Changing All Gauges' Global Properties.




Making WinGauge the Topmost Window

You can always see WinGauge by making it the topmost window. After you do this, the WinGauge window
remains visible above other windows, even when you're working in a different application's window.

To make WinGauge the topmost window:

1.

Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
Choose the Top Most command from the Global menu.

WinGauge adds a check mark at the left of the Top Most command title. Hereafter, the WinGauge
window stays above the other windows you are working with until you turn off this toggle command by
choosing it again.

To turn off the Top Most feature:

1.

Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
Choose the Top Most command from the Global menu again.

WinGauge removes the check mark at the left of the Top Most command title. Hereafter, the
WinGauge window behaves like a regular window, it is hidden below any other windows you are
working with.



Docking/Undocking the WinGauge Window

Tip

While the WinGauge window is docked, you cannot resize gauges interactively by holding down
the Ctrl key and dragging a side or corner of the window. You can, however, rearrange gauges in
the WinGauge window if the titlebar is showing.

You can dock and undock the WinGauge window at any time. When you dock the window, it snaps to the
nearest edge of your desktop.

To dock the WinGauge window:

1.

Point to a gauge and press the Right mouse button.

The WinGauge menu appears.

Choose the Dock WinGauge command from the Global menu.
The WinGauge window snaps to the closest edge of the desktop.

It also changes the Dock WinGauge command title to: Undock WinGauge. The Dock WinGauge
command changes to Undock WinGauge.

While the WinGauge window is docked, you can enable the Auto Hide feature. This temporarily hides
the WinGauge window until you point at the edge of the desktop where the window is hidden. For

procedures about enabling Auto Hide, see Enabling/Disabling the Auto Hide Feature.

To undock the WinGauge window:

1.

Tip

Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
Choose the Undock WinGauge command from the Global menu.

The WinGauge window undocks from the edge of the desktop. The Undock WinGauge command
changes to Dock WinGauge.
You can instantly undock the WinGauge window simply by dragging it's titlebar away from the
edge of your desktop.



Enabling/Disabling the Auto Hide Feature

While the WinGauge window is docked, you can enable the Auto Hide feature, which temporarily hides
the WinGauge window until you point at the edge of the desktop where the window is hidden.

To enable the Auto Hide feature:
1. Point to a gauge and press the Right mouse button.

The WinGauge menu appears.
2. Choose the Enable Auto Hide command from the Global menu.

WinGauge hides the WinGauge window at the edge of your desktop. It also changes the Enable Auto
Hide command to Disable Auto Hide.

To disable the Auto Hide feature:
1. Point to a gauge and press the Right mouse button.

The WinGauge menu appears.
2. Choose the Disable Auto Hide command from the Global menu.

WinGauge shows the WinGauge window at the edge of your desktop. It also changes the Disable
Auto Hide command to Enable Auto Hide.
Tip You can instantly disable the Auto Hide feature by undocking the WinGauge window. To turn off
both features, simply drag the WinGauge window's titlebar away from the edge of your desktop.
When you do this, the Undock WinGauge command changes back to Dock WinGauge, Disable
Auto Hide changes back to Enable Auto Hide, and the window moves to the location where you
dragged it.



Showing/Hiding the WinGauge Window
When the WinGauge window is undocked, you can hide and show it on the desktop.
To hide the WinGauge window:
1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
2. Choose the Hide WinGauge command from the Global menu.

If this command is dimmed, the WinGauge window is docked. You can use the Enable Auto Hide
command to hide the window while it is docked. For more details, see Enabling/Disabling the Auto
Hide Feature.

WinGauge hides the WinGauge window on your desktop. It adds the WinGauge icon to the Windows
taskbar (for Window 95). If you are using Window 3.1x, it minimizes the WinGauge window.

To show the WinGauge window:
Point to the Windows taskbar and double-click the WinGauge icon at the right side of the taskbar (if you're
viewing the time on your taskbar, the icon appears just left of it).

The WinGauge menu reappears.



Showing/Hiding the WinGauge Titlebar

You can hide and show the WinGauge window's titlebar if you want to focus on the gauges inside the
window.

To hide the WinGauge window's titlebar:
1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
2. Choose the Hide Titlebar command from the Global menu.

WinGauge hides the WinGauge window's titlebar, displaying only the gauges in the gauge area. It
also changes the Hide Titlebar command to Show Titlebar.

To show the WinGauge window's titlebar:
1. Point to a gauge and press the Right mouse button.

The WinGauge menu appears.
2. Choose the Show Titlebar command from the Global menu.

WinGauge shows the WinGauge window's titlebar, displaying it above the gauges in the gauge area.
It also changes the Show Titlebar command to Hide Titlebar.



Working With Gauges
You can work with the gauges in the WinGauge window as described in these help topics:

Adding a Gauge

Dragging Application Icons Into WinGauge
Updating a Gauge's Information
Removing a Gauge

Hiding a Gauge

Showing a Gauge
Related Topics

Changing WinGauge Properties




Adding a Gauge
If a gauge doesn't appear in the WinGauge window, you can add it.

Tip When you choose a gauge from a WinGauge menu to add it to the WinGauge window, that
command title remains hidden until you remove the gauge from the WinGauge window.

To add a gauge to the WinGauge window's gauge area:
1. Point to a gauge or to the empty gauge area and press the Right mouse button.

The WinGauge menu appears.
2. Point to or click the New menu.
The New menu appears.
3. Do one of the following:

Choose a <gauge name> command from the New menu.

Point to or click the Memory, Resources, Resources without Hurricane, Drive Space, Drive
Fragmentation, or Performance Data menu.

The menu you chose appears.

Choose a <gauge name> command from the menu.

WinGauge adds the gauge in the WinGauge window and hides the command title from the New
menu until you remove the gauge.



Updating a Gauge's Information
You can update the information for a gauge at any time using the Update command.

Tip In WinGauge, you can specify the Refresh Duration (in seconds) to control how often the gauges'
information should be updated, or refreshed. For details, see Changing a Gauge's Appearance.

To update a gauge's information:
1. Point to a gauge and press the Right mouse button.

The WinGauge menu appears.
2. Choose the Update command.

WinGauge updates the information for the gauge you were pointing at when you chose the Update
command.



Removing a Gauge

You can remove a gauge from the gauge area of the WinGauge window whenever you like. When you do
this, WinGauge saves this information so each time you start WinGauge, the last gauges you were
viewing reappear.

To remove a gauge from the WinGauge window:

1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.

2. Choose the Remove command.

WinGauge removes the gauge you were pointing at when you chose the Remove command. The
command for this gauge is made visible on the New > <gauge name> menu.



Hiding a Gauge

WinGauge lets you show and hide gauges in the WinGauge window.

To hide a gauge:

1. Point to a gauge you want to hide and press the Right mouse button.
The WinGauge menu appears.

2. Choose the Hide command.

WinGauge adds the gauge's name to the Global > Hidden Gauges menu and hides the gauge so it
no longer appears in the WinGauge window.



Showing a Gauge
After you've hidden a gauge, you can show it again.
To show a hidden gauge:
1. Point to the gauge area and press the Right mouse button.
The WinGauge menu appears.
2. Choose the <gauge name> command from the Global > Hidden Gauges menu.

WinGauge redisplays the gauge in the WinGauge window's gauge area, and removes its name from
the Global > Hidden Gauges menu.



Changing WinGauge Properties

WinGauge allows you to customize the properties of gauges. You can select properties as described in
these help topics:

Changing a Gauge's Appearance

Changing All Gauges' Global Properties

Changing a Gauge's Actions
Related Topics

Saving Gauge Settings
Opening Gauge Settings




Changing a Gauge's Appearance

You can change any gauge's appearance individually by selecting the gauge's type, refresh duration,
threshold style, data style, size, gauge text, borders, or colors.

To change a gauge's appearance:
1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.

2. Choose the Properties command.

WinGauge displays the Properties sheet dialog box with the Appearance tab at the front.
3. Select the Appearance properties you want to use as the default or to apply to the selected gauge.

Do one of the following:

Click the Default button to return these Appearance settings to WinGauge's defaults.

Click the Apply button to apply these settings to the selected gauge (or the one you were pointing
at when you chose the Properties command).
The Properties sheet remains open so you can continue selecting properties.

Click the OK to apply these settings to the selected gauge (or the one you were pointing at when
you chose the Properties command).
The Properties sheet closes and the WinGauge window becomes active again.



Changing All Gauges' Global Properties
You can change global properties that affect all gauges.
To change all gauges' global properties:
1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
2. Choose the Properties command.
WinGauge displays the Properties sheet dialog box.
3. Click the Global tab to bring the tab to the front.
The Global tab appears.
Select the Global properties you want to use as the default or to apply to all gauges.

Do one of the following:

Click the Default button to return these settings to WinGauge's default for all gauges.

Click the Apply button to apply these settings to all the gauges in the WinGauge window
(including any hidden ones).
The Properties sheet remains open so you can continue selecting properties.

Click the OK to apply these global settings all the gauges in the WinGauge window (including any
hidden ones).
The Properties sheet closes and the WinGauge window becomes active again.



Changing a Gauge's Actions

Although you may have the gauges you want displayed on the screen, you may also want to be notified
whenever you reach the threshold limits on any gauge. WinGauge allows you to select actions that will be
triggered whenever any of your thresholds are reached. Depending upon your requirements, you can
have WinGauge play a sound, display a message, or even run an application, to alert you to the status of
your system.

To change a gauge's actions:
1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.
2. Choose the Properties command.
WinGauge displays the Properties sheet dialog box.
3. Click the Action tab to bring the tab to the front.
The Actions tab appears.
Select the Actions properties to apply to a gauge you are creating.

5. Do one of the following:

Click the Default button to return these settings to WinGauge's defaults.

Click the Apply button to apply these settings to the gauge that you pointed at, or selected, in the
WinGauge window before you chose the Properties command.
The Properties sheet remains open so you can continue selecting properties.

Click the OK to apply these settings a new gauge that is created in the WinGauge window.

The Properties sheet closes and the WinGauge window becomes active again. The new Actions
gauge you defined appears.



Saving Gauge Settings

After changing the WinGauge window, you can easily save all your settings by name. This lets you reload
it later. This lets you reload these settings later. You can save multiple WinGauge windows, and quickly
reopen any of them you want to see or work with.

Initially, WinGauge opens the Default.wgp file that contains the default WinGauge settings. Most likely,
you'll want to save your settings using a unique name that reminds you of their purpose. Once you've
given the settings a name, simply choose the Save command while those settings are loaded to resave
any further changes you make.

Tip To have WinGauge automatically load using a particular gauge settings file in Windows 95,
specify the filename of the settings file in the WinGauge shortcut's Properties sheet.

To save gauge settings:
1. Point to a gauge and press the Right mouse button.

The WinGauge menu appears.
2. Choose the Save As command from the Settings menu.

WinGauge displays the Save WinGauge Settings dialog box.
3. Enter a filename for these settings.

You should use the file extension of .WGP for WinGauge Settings files.
4. Click Save.



Opening Gauge Settings

You can open (or load) WinGauge settings that you've saved by name earlier, or reopen the Default.wgp
default settings file.

To open gauge settings:

1. Point to a gauge and press the Right mouse button.
The WinGauge menu appears.

2. Choose the Load command from the Settings menu.
WinGauge displays the Load WinGauge Settings dialog box.

3. Select a WinGauge settings file you want to open.
WinGauge settings files use a file extension of WGP.

You can also change the location (drive or folders if you're using Windows 95, or drive and directories
if you're using Windows 3.1x) to find the settings file you want to open.

4. Click Open.



Closing WinGauge

You can close the WinGauge window at any time.

To close the WinGauge window in Windows 95:
Do one of the following to close the WinGauge window:

Press the Right mouse button.
Choose the Close command from the WinGauge menu.

Click the Close box in the WinGauge window's titlebar.

Choose the Close command from the WinGauge menu (or press Alt-F4).
To close the WinGauge window in Windows 3.1x:
Do one of the following to close the WinGauge window:

Double-click the Control-menu box in the WinGauge window's titlebar.

Choose the Close command from the Control menu (or press Alt-F4).



Dragging Application Icons Into WinGauge

As well as displaying gauges to keep you informed of the status of your system, you can use WinGauge
to house application icons and folders, giving you a quick and easy one-stop launch pad. In addition to
freeing up your cluttered desktop, putting application items in WinGauge encourages you to visually
check the status of your gauges regularly.

Tip After creating the application's Action gauge in the WinGauge window, you can select the
properties that determine the gauge's actions.

To drag an application icon into WinGauge:
1. Open the WinGauge window.

2. Open My Computer or Windows Explorer.
3. Locate the application's icon, and drag it into the WinGauge window.

You can also drag icons, files or folders from the desktop into WinGauge.



The WinGauge Window

The WinGauge window is a very flexible, customizable window for displaying gauges that help you keep
track of the state of your computer system.

To examine the individual gauges, see Gauges in WinGauge, which shows a list of the available menus
where you can choose each gauge to display in the WinGauge window. From the menu help topics, you
can select each gauge for a description of its purpose along with related information about the gauge's
warnings and alarms.

Related Topics

Manipulating the WinGauge Window
Working With Gauges

Changing WinGauge Properties
Closing WinGauge




Gauges in WinGauge

You can choose which gauges in to display in WinGauge by choosing them from the pop-up menu. The
gauges you can choose are available from these menus:

The New Menu

The New > Memory Menu

The New > Resources Menu

The New > Drive Space Menu

The New > Drive Fragmentation Menu

The New > Performance Data Menu

The Performance Data > File System Menu

The Performance Data > Memory Manager Menu
The Performance Data > Kernel Menu

The Performance Data > Microsoft Client Network Menu
The Performance Data > Microsoft Client Network Menu

The Performance Data > Microsoft Network Server Menu

Note The gauges that appear on the Performance Data menus are extensible. The system-specific
gauges you see depend upon the capabilities of your computer.



New Menu

The New menu contains commands that let you display these gauges:

Clock Gauge

CPU Activity Gauge

General Protection Faults Gauge
Global Descriptors Gauge

Local Descriptors Gauge

Page Faults Gauge

Ring 3 Mode Switches Gauge
Swap File Requests Gauge

V86 Mode Switches Gauge

Action Gauge



New > Memory Menu

The New > Memory menu contains commands that let you display these gauges:

Discardable Memory Gauge
Global DOS Memory Gauge
Linear Memory Gauge

Physical Memory Gauge

Virtual Memory Gauge

Global Memory Utilitization Gauge
RAM Expander Hit Ratio Gauge

Memory Load Gauge

Extra RAM From RAM Expander Gauge



New > Resources Menu

The New > Resources menu contains commands that let you display these gauges:

User Atom Heap Gauge
GDI 16-bit Heap Gauge
GDI 32-bit Heap Gauge
Highest Resource Gauge
Menu Heap Gauge
String Heap Gauge

Window 16-bit Heap Gauge

Window 32-bit Heap Gauge



New > Drive Space Menu
The New > Drive Space menu contains commands that let you display this gauge for each disk drive on
your PC:

Drive Space Gauge



New > Drive Fragmentation Menu
The New > Drive Fragmentation menu contains commands that let you display this gauge for each disk
drive on your PC:

Drive Fragmentation Gauge



New > Performance Data Menu

The New > Performance Data menu contains these submenus that offer commands for the indicated
areas of performance data reported by your PC's applications to Windows:

The Performance Data > File System Menu

The Performance Data > Memory Manager Menu

The Performance Data > Kernel Menu
The Performance Data > Microsoft Client Network Menu

The Performance Data > Microsoft Client for Netware Networks Menu

The Performance Data > Microsoft Network Server Menu
The commands that are available to you vary, depending upon your computer's capabilities.



Performance Data > File System Menu

The Performance Data > File System menu contains commands that let you display these gauges:

Dirty Data Gauge
Bytes Read/Second Gauge
Bytes Written/Second Gauge

Reads/Second Gauge

Writes/Second Gauge



Performance Data > Memory Manager Menu

The Performance Data > Memory Manager menu contains commands that let you display these gauges:

Allocated Memory Gauge
Maximum Disk Cache Size Gauge
Minimum Disk Cache Size Gauge
Disk Cache Size Gauge

Swap File Defective Gauge

Swap File in Use Gauge

Swap File Size Gauge

Discards Gauge

Page-Outs Gauge

Page-Ins Gauge

Instance Faults Gauge

Page Faults Gauge

Other Memory Gauge

Swappable Memory Gauge

Locked Memory Gauge

Free Memory Gauge



Performance Data > Kernel Menu

The Performance Data > Kernel menu contains commands that let you display these gauges:

Processor Usage (%) Gauge

Virtual Machines Gauge

Threads Gauge



Performance Data > Microsoft Client Network Menu

The Performance Data > Microsoft Client Network menu contains commands that let you display these
gauges:

Number of Open Files Gauge
Number of Open Resources Gauge
Number of Sessions Gauge
Number of Networks Gauge

Bytes Written Per Second Gauge

Bytes Read Per Second Gauge

Transactions Per Second Gauge



Performance Data > Microsoft Client Network Menu

The Performance Data > Microsoft Client Network menu contains commands that let you display these
gauges:

Receive Gap Gauge

Send Gap Gauge

Requests Pending Gauge
Dropped Burst Gauge

Dropped NCP Gauge

Dirty Bytes Cached Gauge

Bytes in Cache Gauge

Bytes Written Per Second Gauge

Bytes Read Per Second Gauge

Transactions Per Second Gauge



Performance Data > Microsoft Network Server Menu

The Performance Data > Microsoft Network menu contains commands that let you display these gauges:

Throughput Gauge
Writes Gauge
Bytes Gauge
Threads Gauge
NBs Gauge

Buffers Gauge

Bytes Gauge



WinGauge Properties Dialog Box

The WinGauge Properties dialog box contains the following tabs of options:

Appearance tab

Global tab

Actions tab



Appearance Tab

The Appearance tab lets you decide what sort of gauge you want, its refresh duration, size, colors,
threshold limits and so on. When you have finished specifying the appearance of the gauge, you can click
Apply to apply the settings to the gauge and leave the Appearance tab open, or OK to apply the settings
and close the Appearance tab. The Default button causes the gauge's appearance to revert back to the
WinGauge default settings.

The Appearance tab contains several sections of options, so that you can customize every gauge
individually.

Type
You can select the gauge type to use from the drop-down list box. The gauge preview shows what the
currently selected gauge type looks like.

The gauge types are: Analog, Digital, LED, Histogram, Thermometer, Horizontal Bar, Vertical Bar, and
Text (%).

Refresh Duration

The Refresh Duration sets how often WinGauge checks the system to update information provided in the
gauge. You can set the refresh duration for each gauge to your own liking, but there is obviously no point
in having, say, your disk fragmentation levels checked every 15 seconds. The default settings should be
OK. To increase or decrease the Refresh Duration, drag the slider to the left or right.

Threshold Style
You can highlight the threshold limits on each gauge by marking the thresholds as a Line or Color. To set
or change the threshold levels, see Changing a Gauge's Actions.

Data Style
Selecting a Data Style of Color Lines, Color Fill, Solid Lines, or Solid Fill makes certain Colors options
visible as described in the Colors section below.

Size
Selecting double wide or tall, both, or default adjusts the gauge size.

Gauge Text
You can select whether to display a gauge's title and value, show the title vertically or horizontally, and
show the value as a percent. You can also select where on the gauge the title and value appear.

Colors

You can customize a gauge by changing the colors. To change the color on any part of the gauge, select
the gauge part and click the Set Color button. A standard Windows Color dialog box appears where you
can select basic colors or define your own custom colors.

You can select colors for the following parts of a gauge:

Text (default black)-Sets the color for gauge text (visible when Gauge Text is set to either or both
the Title and Value).

Regular (default lime green)-Sets the color for regular data usage (visible when Data Style is set
to Color Lines or Color Fill).

Regular Background (default olive green)-Sets the color for the regular background of the
gauge indicator.

Warning Background (default khaki brown)-Sets the color for the warning background of the
gauge indicator.



Alarm Background (default maroon red)-Sets the color for the alarm background of the gauge
indicator.

Warning (default bright yellow)-Sets the color for warning data usage (visible when Data Style is
set to Color Lines or Color Fill).

Alarm (default bright red)-Sets the color for the alarm data usage (visible when Data Style is set
to Color Lines or Color Fill).

Frame (default white)-Select Frame from the Colors drop-down list box. Then select an edge of
the gauge preview to turn on or off the gauge's highlighted edges. You can also change the color used for
the frame in the Color dialog box (click the Set Color button).

Background (default black)-Sets the color for the gauge's data background (visible when
Threshold Style is set to Lines or None).

= Solid Pointer (default white)-Sets the color for the gauge's data usage indicator (visible when
Data Style is set to Solid Lines).



Global Tab

The Global tab contains several sections of options you can select to change the appearance of all
gauges.

Change Dimensions
Drag the sliders at the top and left of the gauge preview to resize all gauges. As you drag the sliders, the
gauge preview changes size in real-time to show the current dimensions for all gauges.

Gauge Title Font, Gauge Value Font, and Gauge Font

Click the Select Font button to select a different font family, font style, or font size for all gauges' titles,
values, or gauge fonts, respectively. WinGauge displays a standard Font dialog box where you can select
from the fonts available on your computer.

Tip Title text is visible when the Title check box is selected in the Gauge Text section of the
Appearance tab. Value text is visible when the Value check box is selected. The fonts for titles
and values are set in the Gauge Title Font section and Gauge Font section. The Gauge Font is
the font used when you select a gauge type of Text Gauge.

Show Bubble Help

Select the Show Bubble Help check box to display Bubble Help when you point to a gauge and wait for
the specified delay time. Drag the Delay slider left or right to change the delay (in seconds). The shortest
delay is one second and the longest is ten seconds.



Actions Tab

The Action tab contains several sections of options you can select.

Invert Alarms

WinGauge allows you to set up your gauges to monitor both increasing and decreasing values. Normally,
you will want your gauges to show you what proportion of an available total you are using. That is, you
want to see how "full" your gauge is and how close you are to reaching the upper limits. Typically, you
would use a regular gauge to monitor a value that is increasing, such as occupied disk space. But
occasionally, you will need to monitor a value that is dropping, such as available disk space.

To monitor reducing values, select the Invert Alarms check box.

The roles of threshold levels and alarm levels in Regular Alarms and Inverted Alarms are best explained
by the following examples:

If you are monitoring occupied disk space, you would use Regular Alarms and could set your
warning threshold to 90% full with an alarm to be triggered when your disk becomes 95% full.

If you are monitoring available disk space, you would use Inverted Alarms, and could set your
warning threshold to 10% available, with an alarm being triggered when your available disk space drops
to 5%.

Enable Warnings/Enable Alarms

Select the Enable Warnings or Enable Alarms check boxes to receive warnings or alarms, respectively, in
WinGauge. After you select one or both of these check boxes, their related options become active. While
they are deselected, the related options are dimmed. You can select any combination of the following
options:

Threshold-Drag the Threshold sliders left or right to specify the percent at which a warning or
alarm should take place. The Warnings and Alarms thresholds are constrained to each other on the
threshold range (from Off to 100%). This constraint relationship is determined by whether the Invert
Alarms check box is selected.

When the Invert Alarms check box is deselected, you can set the Warnings Threshold percent
equal to or less than the Alarms Threshold percent. The Alarms Threshold constrains the range available
for the Warnings Threshold. For example, if you set the Alarms Threshold to 40%, you can subsequently
set the Warnings Threshold at a value constrained between Off to 40%. You can then drag the Alarms
Threshold slider above 40% and the Warnings Threshold remains the same. However, if you drag the
Alarms Threshold slider below the current Warnings Threshold's percent (in this case, below 40%), the
Warnings Threshold slider "locks in" and decreases matching the Alarms Threshold percent.

When the Invert Alarms check box is selected, you can set the Alarms Threshold percent equal to or
less than the Warnings Threshold percent. The Warnings Threshold constrains the range available for
the Alarms Threshold.

Pop-up Dialog-Select the Pop-up Dialog check box to see a pop-up dialog box when the gauge,
reaches the threshold.

Sound-Select the Sound check box to select a sound (a .WAV file) to play when the threshold is
reached for this gauge. After selecting the Sound check box, you can click the Folder button to select the
sound file to use, in the same way that you select sounds for other Windows applications or events.

Run-Select the Run check box to select an application (an .EXE file) to run when the gauge
reaches the threshold. You can click Folder to select the application to use. The Action File dialog box
appears where you can enter a path to the application file, or browse to find it. You can also select



whether the application should run in a normal window, or be minimized or maximized.



Clock Gauge

The Clock gauge displays the date in the MM/DD/YYYY format, a clock showing the time using the format
you select (analog, digital or text), and the day of the week. The WinGauge clock uses the date and time
currently set with the Windows Date/Time control panel.

Related Topics
Clock Alarm



CPU Activity Gauge

The CPU Activity gauge displays the percentage of time that your computer's CPU (central processing
unit) is busy.

Related Topics
CPU Activity Alarm



General Protection Faults Gauge

The General Protection Faults gauge displays the percentage of "handled" general protection faults
(GPFs). The GPF percent is the number of GPFs out of the total number of accesses of a virtual (shared)
I/0O port and system interrupt requests made by Windows applications.

Windows uses handled GPFs to determine and control the state of the currently executing application.
GPFs that Windows does not expect cause a system error message to appear.

Related Topics
General Protection Faults Alarm



Global Descriptors Gauge

The Global Descriptors gauge displays GDT (Global Descriptor Table) activity. A low reading (zero to 10
percent) is normal. Over 50 percent could indicate a problem with one of the devices listed in the
[386Enh] section of your SYSTEM.INI file.

Tip Information about the Global Descriptor Table is available in DiscoverPro. Click the Software tab,
the Advanced button, and the Descriptors icon.

Related Topics
Global Descriptors Alarm



Local Descriptors Gauge

The Local Descriptors gauge displays LDT (Local Descriptor Table) activity. A very high reading (75
percent or more) indicates a problem.

Tip Information about the Local Descriptor Table is available in DiscoverPro. Click the Software tab,
the Advanced button, and the Descriptors icon.

Related Topics
Local Descriptors Alarm



Page Faults Gauge

The Page Faults gauge displays the percentage of page faults. The page faults percent is the number of
page faults out of the total number of times a Windows application accesses reserved but empty memory
or an instanced (localized) part of global memory.

Related Topics
Page Faults Alarm



Ring 3 Mode Switches Gauge

The Ring 3 Mode Switches gauge displays the number of switches to the Ring 3 mode as a percentage of
the total mode switches. Windows operates using three distinct modes of the CPU that it switches among
when you are using your PC:

Ring 3 mode where applications run

V86 mode where DOS, and its drivers and applications run

Ring 0 mode where the Windows Virtual Devices run

Tip Information about Ring 3 mode interrupts is available in DiscoverPro. Click the Software tab, the
Advanced button, and the Interrupts icon. You can also see interrupt request information in
DiscoverPro by clicking the System tab, the Advanced button, and the DMA/IRQ icon.

Related Topics
Ring 3 Mode Switches Alarm



Swap File Requests Gauge

The Swap File Requests gauge displays the number of swap file requests in percent. This is the number
of times Windows needed to access the virtual memory swap file rather than the RAM (or physical
memory) in your PC. Each request takes roughly 4 K. The more often this gauge changes, the slower
your computer system will run.

Related Topics
Swap File Requests Alarm



V86 Mode Switches Gauge

The V86 Mode Switches gauge displays the number of V86 mode switches in percent. This is the number
of times that Windows talks to DOS or the BIOS (Basic Input/Output System).

Tip Information about BIOS is available in DiscoverPro. Click the Software tab, the Advanced button,
and the BIOS/CMOS icon.

Related Topics
V86 Mode Switches Alarm



Action Gauge

Choose the Action Gauge command to create your own custom gauge. When you choose this command,
WinGauge display the Properties dialog box where you can select an action file (an application's .EXE
file, or any document file) that should be run when you click the gauge. You can also select an icon to use
with your action gauge.

For example, you could create an action gauge for the standard Windows Notepad application to give you
instant access to it.



Discardable Memory Gauge

The Discardable Memory gauge displays the percent of all running applications' discardable memory that
Windows has not discarded. That is, discardable memory that is present in physical memory. Each
application marks the segments that make up that application to indicate which ones are discardable
(segments that Windows can discard to provide memory to other applications).

Related Topics
Discardable Memory Alarm



Global DOS Memory Gauge

The Global DOS Memory gauge displays the amount of Global DOS Memory used as a percent of the
total DOS memory available to Windows. Applications use global DOS memory to communicate and
maintain compatibility with DOS (the Disk Operating System).

Tip Information about Global DOS Memory is available in DiscoverPro. Click the Memory tab, the
Advanced button, and the Global DOS icon.

Related Topics
Global DOS Memory Alarm



Linear Memory Gauge

The Linear Memory gauge displays the amount of linear memory used as a percent of the total linear
memory available to Windows applications.

Tip Information about linear memory is available in DiscoverPro. Click the Memory tab, the Advanced
button, and the Program Memory or System Memory icons.

Related Topics
Linear Memory Alarm




Physical Memory Gauge

The Physical Memory gauge displays the amount of physical memory (RAM) used as a percent of the

total amount of RAM available to Windows.

Tip Information about physical memory (or RAM) is available in DiscoverPro. Click the Memory tab,
the Advanced button, and the Physical Memory, Global DOS, or First Meg icons.

Related Topics
Physical Memory Alarm



Virtual Memory Gauge

The Virtual Memory gauge displays the amount of virtual memory (the swap file) used as a percent of the
total amount of virtual memory available to Windows.

Related Topics
Virtual Memory Alarm



Global Memory Utilization Gauge

The Global Memory Utilization gauge displays the amount of global memory utilized as a percent of the
total amount of global memory available.

Tip Information about global memory is available in DiscoverPro. Click the Memory tab, the Advanced
button, and the Global DOS icon.

Related Topics
Global Memory Utilization Alarm



RAM Expander Hit Ratio Gauge

(Windows 95 only.) The RAM Expander Hit Ratio gauge displays the ratio of RAM expander hits
dynamically if you are also using the RAM Expander. The RAM Expander is a Hurricane utility by Helix
Software that uses a patented RAM compression feature to reduce your system's need for disk-based
virtual memory, thus speeding up your system.

To determine the hit ratio, WinGauge divides the number of total swaps to the RAM Expander by the
number of total Windows 95 swaps (to the swap file or the RAM Expander).

Related Topics
RAM Expander Hit Ratio Alarm



Memory Load Gauge

(Windows 95 only.) The Memory Load gauge displays the percentage being used of all of physical
memory minus the amount that's being used by the disk cache (a dynamic holding buffer in RAM for the

most recently used data).

Related Topics
Memory Load Alarm



Extra RAM From RAM Expander Gauge

(Windows 95 only.) The Extra RAM from RAM Expander gauge displays the amount of extra RAM made
available by RAM Expander if you are also using that Hurricane utility.

Related Topics
Extra RAM From RAM Expander Alarm



User Atom Heap Gauge

The User Atom Heap gauge displays the percentage of user atom heap usage. The user atom heap is a
resource heap located in memory that contains mostly Window titles.

Tip Information about the User Atom Heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then scroll down in the User Objects list.

Related Topics
User Atom Heap Alarm



GDI 16-bit Heap Gauge

The GDI 16-bit Heap gauge displays the percentage of GDI 16-bit heap usage. GDI is a component of
Windows that is responsible for drawing graphics on your screen or printer.

The GDI 16-bit heap is a resource heap for keeping pens, brushes, fonts, and other information for
handling graphics when you're running 16-bit applications.

Tip Information about the GDI 16-bit heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then examine the GDI Objects list.

Related Topics
GDI 16-bit Heap Alarm



GDI 32-bit Heap Gauge

The GDI 32-bit Heap gauge displays the percentage of GDI 32-bit heap usage. GDI is a component of
Windows that is responsible for drawing graphics on your screen or printer.

The GDI 32-bit heap is a resource heap for keeping pens, brushes, fonts, and other information for
handling graphics when you're running 32-bit applications.

Tip Information about the GDI 32-bit heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then scroll down in the GDI Objects list.

Related Topics
GDI 32-bit Heap Alarm



Highest Resource Gauge

The Highest Resource gauge displays the percentage of highest resource usage. System resources are
managed by the GDI and User programs, so the highest resource usage can be either a GDI or User
resource, depending upon the kind of activities taking place.

Related Topics
Highest Resource Alarm



Menu Heap Gauge

The Menu Heap gauge displays the percentage of menu heap usage. The menu heap contains
information about drop-down menus.

Tip Information about the menu heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then scroll down in the User Objects list.

Related Topics
GDI Menu Heap Alarm



String Heap Gauge

The String Heap gauge displays the percentage of menu string heap usage. The menu string heap
contains text information about menu titles.

Tip Information about the string heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then examine the User Objects list.

Related Topics
String Heap Alarm



Window 16-bit Heap Gauge

The Window 16-bit Heap gauge displays the percentage of 16-bit user Windows Heap usage. The 16-bit
user Windows Heap contains information about windows and controls (for Windows 3.1x or 16-bit
applications).

Tip Information about the Windows 16-bit Heap is available in DiscoverPro. Click the Software tab,
the Advanced button, and the System Resources icon. Then examine the User Objects list.

Related Topics
Window 16-bit Heap Alarm



Window 32-bit Heap Gauge

The Window 32-bit Heap gauge displays the percentage of Windows 32-bit Heap usage. The 32-bit
Windows Heap contains information about windows and controls (for Windows 95 or 32-bit applications).

Tip Information about the Window 32-bit Heap is available in DiscoverPro. Click the Software tab, the
Advanced button and the System Resources icon. Then scroll down in the User Objects list.

Related Topics
Window 32-bit Heap Alarm



Drive Space Gauge

The Space <drive letter>: gauges display the percentage of drive space in use for each drive on your PC.
If a drive uses some kind of removable storage media, such as a 3.5-inch disk, a CD-ROM disc, or a tape
cartridge, the percentage is at zero until you insert the storage media into the drive.

Related Topics
Drive Space Alarm



Drive Fragmentation Gauge

The Fragmentation <drive letter>: gauges display the percentage of fragmentation for each drive where
you can write information. For example, a hard drive can become fragmented over time, but a read-only
CD-ROM drive cannot (so its drive letter is not available on the Drive Fragmentation menu).

Fragmentation happens because as you use a drive over time to store information, you save, resave, and
delete files. The storage space that is freed up after a file has been deleted can be reused. However, the
amount of space that was used for a deleted file may not be exactly the same amount needed for a file
you're saving later. So the information in a file may be stored in multiple places on a drive.

If a drive uses some kind of removable storage media that you can write information to, such as a 3.5-
inch disk or a tape cartridge, the percentage is at zero until you insert the disk or cartridge into the drive.

Related Topics
Drive Fragmentation Alarm



Dirty Data Gauge

The Dirty Data gauge displays the amount of dirty data, or the number of bytes waiting to be written to the
disk. Dirty data is kept on a per cache block basis, and so a number higher than the actual number of
bytes waiting to be written may be reported.

Related Topics
Dirty Data Alarm



Bytes Read/Second Gauge
The Bytes Read/Second gauge displays the number of bytes read from the file system per second.

Related Topics
Bytes Read/Second Alarm



Bytes Written/Second Gauge
The Bytes Written/Second gauge displays the number of bytes written to the file system per second.

Related Topics
Bytes Written/Second Alarm



Reads/Second Gauge

The Reads/Second gauge displays the number of read requests made to the file system per second.

Related Topics
Read/Second Alarm



Writes/Second Gauge

The Writes/Second gauge displays the number of write requests made per second to the file system.

Related Topics
Writes/Second Alarm



Allocated Memory Gauge

The Allocated Memory gauge displays the number of bytes of memory allocated, or committed, in the

system. This is the total amount of memory that has been allocated in the system, across all components
and applications.

Related Topics
Allocated Memory Alarm



Maximum Disk Cache Size Gauge

(Windows 95 only.) The Maximum Disk Cache Size gauge displays the maximum size of the Windows 95
VCACHE disk cache. A disk cache is an area of RAM where recently used information is stored (in case it
is requested again soon by an application) to speed up processing.

Related Topics
Maximum Disk Cache Size Alarm



Minimum Disk Cache Size Gauge

(Windows 95 only.) The Minimum Disk Cache Size gauge displays the minimum size of the Windows 95
VCACHE disk cache.

Related Topics
Minimum Disk Cache Size Alarm



Disk Cache Size Gauge

(Windows 95 only.) The Disk Cache Size gauge displays the current size of the Windows 95 VCACHE
disk cache. Windows 95 uses algorithms to dynamically increase or decrease the size of the VCACHE
depending upon the situation.

Related Topics
Disk Cache Size Alarm



Swap File Defective Gauge

(Windows 95 only.) The Swap File Defective gauge displays the number of bytes in the swap file found to
be physically defective on the system hard drive where the swap file resides. The system hard drive is the
drive that contains your Windows folder.

Windows allocates swap file space in 4K frames, so a single damaged sector causes the entire frame to
be marked defective.

Related Topics
Swap File Defective Alarm



Swap File in Use Gauge

The Swap File in Use gauge displays the amount of the swap file that is currently in use in bytes.

Related Topics
Swap File in Use Alarm



Swap File Size Gauge

The Swap File Size gauge displays the total size of the swap file in bytes.

Related Topics
Swap File Size Alarm



Discards Gauge

The Discards gauge displays the number of page discards per second. Pages are segments of
information that Windows moves between RAM and the swap file on the system hard drive.

Related Topics
Discards Alarm



Page-Outs Gauge

The Page-Outs gauge displays the number of page-out operations per second. Paging out is the process
Windows uses to save information in RAM out to the hard disk so it can reassign that RAM to a different

linear address.

Related Topics
Page-Outs Alarm



Page-Ins Gauge

The Page-Ins gauge displays the number of page-in operations per second. Paging in is the process
Windows uses to read information from the hard disk into RAM.

Related Topics
Page-Ins Alarm



Instance Faults Gauge

The Instance Faults gauge displays the number of instance faults taken per second.

Related Topics
Instance Faults Alarm



Page Faults Gauge

The Page Faults gauge displays the number of page faults taken per second. A page fault happens each
time an application accesses reserved but empty linear memory, or an instanced (localized) part of global

memory.

Related Topics
Page Faults Alarm



Other Memory Gauge

The Other Memory gauge displays the number of bytes of memory allocated that are not stored in the
swap file. Examples of other memory include disk cache pages, memory allocated fixed (non-pageable),
and memory-mapped files.

Related Topics
Other Memory Alarm



Swappable Memory Gauge

The Swappable Memory gauge displays the number of bytes of memory allocated from the swap file.
Swap file pages that are locked still count as swappable in calculating this value.

Related Topics
Swappable Memory Alarm



Locked Memory Gauge

The Locked Memory gauge displays the amount of RAM that is allocated by Windows to applications
which is locked by those applications.

Related Topics
Locked Memory Alarm



Free Memory Gauge
The Free Memory gauge displays the amount of RAM that is free, or available for use.

Related Topics
Free Memory Alarm



Processor Usage (%) Gauge

The Percentage Usage (%) gauge displays the percent of your PC's CPU (central processing unit) time
that is busy (or not spent idle). This value is approximate.

Related Topics

Processor Usage (%) Alarm



Virtual Machines Gauge

The Virtual Machines gauge displays the number of virtual machines present in the system. A virtual
machine, such as the Windows System VM or a virtual DOS machine, is software that emulates all the
capabilities of a PC for an application.

Tip Information about Virtual Machines is available in DiscoverPro. Click the Software tab, the
Advanced button, and the Windows VMs icon.

Related Topics
Virtual Machines Alarm



Threads Gauge

The Threads gauge displays the number of processor threads present in the system. A thread is part of a
process (or task) performed by an application. Depending upon how the application is designed, a thread
could be printing a document, recalculating values, or sorting information.

Tip Information about Threads is available in DiscoverPro. Click the Software tab, the Advanced
button, and the Threads icon.

Related Topics
Threads Alarm



Number of Open Files Gauge
The Number of Open Files gauge displays the number of open files on the network.

In Windows 3.1x, for example, the maximum number of open files is 255. Open files include not only the
application and document files that you have open, but also DLL files and font files used by an
application.

Related Topics
Number of Open Files Alarm



Number of Resources Gauge

The Number of Resources gauge displays the number of resources.

Related Topics
Number of Resources Alarm



Number of Sessions Gauge

The Number of Sessions gauge displays the number of sessions.

Related Topics
Number of Sessions Alarm



Number of Networks Gauge

The Number of Networks gauge displays the number of networks running.

Related Topics
Number of Networks Alarm



Bytes Written Per Second Gauge
The Bytes Written Per Second gauge displays the number of bytes written to the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Bytes Written Per Second Alarm



Bytes Read Per Second Gauge
The Bytes Read Per Second gauge displays the number of bytes read from the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Bytes Read Per Second Alarm



Transactions Per Second Gauge

The Transactions Per Second gauge displays the number of SMB transactions per second.

Related Topics
Transactions Per Second Alarm



Receive Gap Gauge

The Receive Gap gauge displays the burst receive gap time, or interpacket gap for incoming burst traffic,
in microseconds.

Related Topics
Receive Gap Alarm



Send Gap Gauge

The Send Gap gauge displays the burst send gap time, or interpacket gap for out-going burst traffic, in
microseconds.

Related Topics
Send Gap Alarm



Requests Pending Gauge

The Requests Pending gauge displays the number of requests waiting to be processed by the network
server.

Related Topics
Requests Pending Alarm



Dropped Burst Gauge

The Dropped Burst gauge displays the number of burst packets dropped (the number of burst protocol
packets lost in transit).

Related Topics
Dropped Burst Alarm



Dropped NCP Gauge

The Dropped NCP gauge displays the number of CP packets dropped (the number of regular NCP
packets lost in transit).

Related Topics
Dropped NCP Alarm



Dirty Bytes Cached Gauge

The Dirty Bytes Cached gauge displays the amount of dirty data in bytes that is currently stored in the
disk cache by the redirector and waiting to be written.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Dirty Bytes Cached Alarm



Bytes in Cache Gauge
The Bytes in Cache gauge displays the amount of data in bytes that is currently cached by the redirector.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Bytes in Cache Alarm



Bytes Written Per Second Gauge
The Bytes Written Per Second gauge displays the number of bytes written to the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Bytes Written Per Second Alarm



Bytes Read Per Second Gauge
The Bytes Read Per Second gauge displays the number of bytes read from the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

Related Topics
Bytes Read Per Second Alarm



Transactions Per Second Gauge

The Transactions Per Second gauge displays the number of SMB transactions per second.

Related Topics
Transactions Per Second Alarm



Throughput Gauge
The Throughput gauge displays the total of disk reads and writes in bytes per second.

Related Topics
Throughput Alarm



Writes Gauge

The Bytes Written Per Second gauge displays the disk writes in bytes per second.

Related Topics
Writes Alarm



Bytes Gauge
The Bytes Read Per Second gauge displays the disk reads in bytes per second.

Related Topics
Bytes Alarm



Threads Gauge

The Threads gauge displays the number of server threads, which are Windows threads used by the
server.

Related Topics
Threads Alarm



NBs Gauge

The Network Buffers gauge displays the number of server network buffers.

Related Topics
NBs Alarm



Buffers Gauge

The Buffers gauge displays the number of server working buffers.

Related Topics
Buffers Alarm



Bytes Gauge
The Bytes gauge displays the amount of memory used by the server in bytes.

Related Topics
Bytes Alarm



Battery Power Gauge
The Battery Power gauge displays the amount of battery power remaining in your portable PC.

Related Topics
Battery Power Alarm



Cache Hits Gauge
The Cache Hits gauge displays the number of cache hits.

Related Topics
Cache Hits Alarm



GDI Heap Without Hurricane Gauge

The GDI Heap Without Hurricane gauge displays the percentage of GDI heap usage if you are not using
the Heap Expander provided with Helix Software's Hurricane software. GDI is a component of Windows
that is responsible for drawing graphics on your screen or printer.

The GDI heap is a resource heap for keeping pens, brushes, fonts, and other information for handling
graphics when you're running applications.

Tip Information about the GDI heap is available in DiscoverPro. Click the Software tab, the Advanced
button, and the System Resources icon. Then examine the GDI Objects list.

Related Topics
GDI Heap Without Hurricane Alarm



Window Heap Without Hurricane Gauge

The Window Heap Without Hurricane gauge displays the percentage of user Windows Heap usage if you
are not using the Heap Expander provided with Helix Software's Hurricane software. The user Windows
Heap contains information about windows and controls for Windows applications.

Tip Information about the Windows Heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then examine the User Objects list.

Related Topics
Window Heap Without Hurricane Alarm



Menu Heap Without Hurricane Gauge

The Menu Heap Without Hurricane gauge displays The Menu Heap gauge displays the percentage of
menu heap usage if you are not using the Heap Expander provided with Helix Software's Hurricane
software. The menu heap contains information about drop-down menus.

Tip Information about the menu heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then scroll down in the User Objects list.

Related Topics
Menu Heap Without Hurricane Alarm



String Heap Without Hurricane Gauge

The String Heap Without Hurricane gauge displays the percentage of menu string heap usage if you are
not using the Heap Expander provided with Helix Software's Hurricane software. The menu string heap
contains text information about menu titles.

Tip Information about the string heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then examine the User Objects list.

Related Topics
String Heap Without Hurricane Alarm



Atom Heap Without Hurricane Gauge

The Atom Heap Without Hurricane gauge displays the percentage of user atom heap usage if you are not
using the Heap Expander provided with Helix Software's Hurricane software. The user atom heap is a
resource heap located in memory that contains mostly Window titles.

Tip Information about the User Atom Heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon. Then scroll down in the User Objects list.

Related Topics
Atom Heap Without Hurricane Alarm



GDI Atom Heap Without Hurricane Gauge

The GDI Atom Heap Without Hurricane gauge displays the percentage of GDI atom heap usage if you are
not using the Heap Expander provided with Helix Software's Hurricane software. The GDI atom heap is a
resource heap located in memory that contains font related information including font names.

Tip Information about the GDI Atom Heap is available in DiscoverPro. Click the Software tab, the
Advanced button, and the System Resources icon.

Related Topics
GDI Atom Heap Without Hurricane Alarm



Ping Gauge

The Ping gauge displays the results of a Ping test you've set up to determine whether your connection to
a host on the Internet is working properly. Ping is a program that sends an Internet Control Message
Protocol (ICMP) echo packet to an Internet host you specify. The Ping gauge reports the amount of time
the response took in milliseconds.

Related Topics
Ping Alarm



URL Minder Gauge

The URL Minder periodically queries a specified Internet URL (Universal Resource Locator) address to
see if it has changed since the last time it was queried. A URL is the address of an Internet server or of a
file that is available on an Internet server. The URL Minder gauge shows if a URL address has changed.
That is, if the file associated with the URL address has been updated or if it is no longer available.

Related Topics
URL Minder Alarm



Registry Performance Data Gauges

The Registry Performance Data gauges are extensible. They display information passed from your PC to
Windows, and the gauges available depend upon the capabilities of your computer. You can display
Performance Data gauges by choosing them from these submenus on the Performance Data menu:

The Performance Data > File System Menu
Dirty Data Gauge

Bytes Read/Second Gauge

Bytes Written/Second Gauge
Reads/Second Gauge

Writes/Second Gauge

The Performance Data > Memory Manager Menu
Allocated Memory Gauge

Maximum Disk Cache Size Gauge
Minimum Disk Cache Size Gauge

Disk Cache Size Gauge

Swap File Defective Gauge

Swap File in Use Gauge

Swap File Size Gauge

Discards Gauge

Page-Outs Gauge

Page-Ins Gauge

Instance Faults Gauge

Page Faults Gauge

Other Memory Gauge

Swappable Memory Gauge



Locked Memory Gauge

Free Memory Gauge

The Performance Data > Kernel Menu

Processor Usage (%) Gauge

Virtual Machines Gauge

Threads Gauge

The Performance Data > Microsoft Client Network Menu
Number of Open Files Gauge

Number of Open Resources Gauge

Number of Sessions Gauge

Number of Networks Gauge

Bytes Written Per Second Gauge

Bytes Read Per Second Gauge

Transactions Per Second Gauge

The Performance Data > Microsoft Client Network Menu
Receive Gap Gauge

Send Gap Gauge

Reguests Pending Gauge

Dropped Burst Gauge

Dropped NCP Gauge

Dirty Bytes Cached Gauge

Bytes in Cache Gauge

Bytes Written Per Second Gauge



Bytes Read Per Second Gauge

Transactions Per Second Gauge

The Performance Data > Microsoft Network Server Menu

Throughput Gauge
Writes Gauge
Bytes Gauge
Threads Gauge
NBs Gauge

Buffers Gauge

Bytes Gauge
Related Topics

Registry Performance Data Alarms




Clock Alarm

Your PC has reached the Alarm Threshold set for the Clock gauge in the WinGauge Properties sheet's
Actions tab.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



CPU Activity Alarm

Your PC has reached the Alarm Threshold set for the CPU Activity gauge in the WinGauge Properties
sheet's Actions tab.

The CPU Activity gauge displays the percentage of time that your computer's CPU is busy.

If you are using more than one 16-bit application in Windows 3.1x or Windows 95 and the CPU Activity
percentage is high, you can exit all but the application which is performing the most important, or time
critical task. This lets you finish the task on your "critical path" as quickly as possible. Windows 3.1x
provides cooperative multitasking, which sometimes causes one application's use of the CPU to slow
down other applications that must wait for processor time.

Windows 95 uses preemptive multitasking and multithreading with 32-bit applications. This reduces the
instances of one 32-bit application's CPU usage slowing down other application. However, if you are
rendering a wireframe image in a 3D modeling program, calculating a spreadsheet in another program,
and drawing 24-bit color fractals in yet a third program, remember that each program requires substantial
processing time with the single CPU in your computer.



General Protection Faults Alarm

Your PC has reached the Alarm Threshold set for the General Protection Faults gauge in the WinGauge
Properties sheet's Actions tab.

Windows uses General Protection Faults (GPFs) to determine and control the state of the currently
executing application.

The General Protection Faults gauge is a faults counter which measures the activity level of this fault
condition. A lower number is better because it indicates that less overhead is required by Windows to
manage the system.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Global Descriptors Alarm

Your PC has reached the Alarm Threshold set for the Global Descriptors gauge in the WinGauge
Properties sheet's Actions tab.

A low reading (from zero to 10 percent) is normal. A gauge reading of over 50 percent could indicate a
problem with one of the devices listed in the [386Enh] section of your SYSTEM.INI file.



Local Descriptors Alarm

Your PC has reached the Alarm Threshold set for the Local Descriptors gauge in the WinGauge
Properties sheet's Actions tab.

Local Descriptor Tables (LDTs) are used by Windows applications to access memory. A very high reading
(75 percent or more) indicates a problem, which means you should close some of the applications you
are running.

Related Topics
Understanding Windows Memory



Page Faults Alarm

Your PC has reached the Alarm Threshold set for the Page Faults gauge in the WinGauge Properties
sheet's Actions tab.

The Page Faults gauge is a faults counter which measures the activity level of this fault condition. A lower
number is better because it indicates that less overhead is required by Windows to manage the system.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Ring 3 Mode Switches Alarm

Your PC has reached the Alarm Threshold set for the Ring 3 Mode Switches gauge in the WinGauge
Properties sheet's Actions tab.

The Ring 3 Mode Switches gauge is a faults counter which measures the activity level of this fault
condition. A lower number is better because it indicates that less overhead is required by Windows to

manage the system.
By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Swap File Requests Alarm

Your PC has reached the Alarm Threshold set for the Swap File Requests gauge in the WinGauge
Properties sheet's Actions tab.

The Swap File Requests gauge displays the number of swap file requests in percent. The more often this
gauge changes, the slower your computer will run. If this percent is high, you can reduce it by installing
more physical memory (RAM) in your computer.



V86 Mode Switches Alarm

Your PC has reached the Alarm Threshold set for the V86 Mode Switches gauge in the WinGauge
Properties sheet's Actions tab.

The V86 Mode Switches gauge is a faults counter which measures the activity level of this fault condition.
A lower number is better because it indicates that less overhead is required by Windows to manage the
system.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Discardable Memory Alarm

Your PC has reached the Alarm Threshold set for the Discardable Memory gauge in the WinGauge
Properties sheet's Actions tab.

The Discardable Memory gauge displays the percent of all running applications' discardable memory that
Windows has not discarded from physical memory. The Discardable Memory gauge indicates Windows'
current reserves, but having too much discardable memory on reserve can reduce performance if
Windows is not making these reserves quickly and efficiently available to applications.

If this percentage is too high, consider obtaining Helix Software's Hurricane software. Hurricane's Heap
Expander has a Free Unused on Minimize feature that makes the most efficient use of discardable
memory.

Related Topics
Understanding Windows Memory



Global DOS Memory Alarm

Your PC has reached the Alarm Threshold set for the Global DOS Memory gauge in the WinGauge
Properties sheet's Actions tab.

Global DOS memory is needed by Windows and Windows applications to communicate and maintain
compatibility with DOS. If you run too low on Global DOS memory, you will not be able to launch new
programs.

To resolve this problem, you can install EMM386 or obtain a copy of Helix Software's Hurricane or
NETROOM software packages. The Hurricane Global DOS Memory Manager usually eliminates this
problem. If you find you still run low on DOS memory try increasing the Global DOS Memory Manager
settings, or using a Conventional memory manager, such as Helix Software's NETROOM.

Related Topics
Understanding Windows Memory



Linear Memory Alarm

Your PC has reached the Alarm Threshold set for the Linear Memory gauge in the WinGauge Properties
sheet's Actions tab.

If you are using Windows 95, you should not run too low on linear memory, but should this happen, you
can increase the linear memory by freeing up disk space on the Windows drive.

If you are using Windows 3.1x, you might run low on linear memory. You can solve this problem by
increasing the size of your Windows swap file using the Windows Control Panel. Or you can increase the
PAGEOVERCOMMIT=# setting in the SYSTEM.INI file to a value between 5 and 16 and then increase
the size of your swap file.

Related Topics
Understanding Windows Memory



Physical Memory Alarm

Your PC has reached the Alarm Threshold set for the Physical Memory gauge in the WinGauge
Properties sheet's Actions tab.

If you run low on physical memory, Windows will use virtual memory in the swap file on your Windows
system drive more often to ensure that applications get access to the physical memory they need to run.

Physical RAM is the fastest kind of memory, so if you continue running low, consider installing more RAM
to improve your PC's performance.

Related Topics
Understanding Windows Memory



Virtual Memory Alarm

Your PC has reached the Alarm Threshold set for the Virtual Memory gauge in the WinGauge Properties
sheet's Actions tab.

The Virtual Memory gauge displays the amount of virtual memory (the swap file) used as a percent of the
total amount available to Windows. If this percentage gets high, you can close some applications, free up
storage space on the Windows system drive (by deleting or zipping files), increase the size of the swap
file. In Windows 3.1x you need to do this yourself, but in Windows 95, the swap file size is dynamic--that
is, it shrinks or grows within the available disk space based on the needs of your applications. If you can't
free up more disk space or increase the size of the swap file on the drive where it is currently located, you
can move the swap file to a different drive.

Related Topics
Understanding Windows Memory



Global Memory Utilization Alarm

Your PC has reached the Alarm Threshold set for the Global Memory Utilization gauge in the WinGauge
Properties sheet's Actions tab.

The Global Memory Utilization gauge displays the amount of global memory utilized as a percent of the
total amount of global memory available.

If the Global Memory Utilization percent is high, you can make more memory available by installing more
physical memory (RAM), increasing the size of the swap file, or moving the swap file to a different drive.

Related Topics
Understanding Windows Memory



RAM Expander Hit Ratio Alarm

Your PC has reached the Alarm Threshold set for the RAM Expander Hit Ratio gauge in the WinGauge
Properties sheet's Actions tab.

(Windows 95 only.) The RAM Expander Hit Ratio gauge displays the ratio of RAM expander hits
dynamically if you are also using the RAM Expander.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Memory Load Alarm

Your PC has reached the Alarm Threshold set for the Memory Load gauge in the WinGauge Properties
sheet's Actions tab.

(Windows 95 only.) The Memory Load gauge displays the percentage being used of all of physical
memory minus the amount that's being used by the disk cache (a dynamic holding buffer in RAM for the
most recently used data).

If the Memory Load percent is large, it indicates that more physical memory is available on your PC and
Windows is storing less recently used data in the disk cache. If the percent is small, you may want to get
more physical memory (RAM).

Related Topics
Understanding Windows Memory



Extra RAM From RAM Expander Alarm

Your PC has reached the Alarm Threshold set for the Extra RAM From RAM Expander gauge in the
WinGauge Properties sheet's Actions tab.

(Windows 95 only.) The Extra RAM from RAM Expander gauge displays the amount of extra RAM made
available by RAM Expander if you are also using that Hurricane utility.

If this amount is small, you may want to change the RAM Expander compression options to increase the
amount of compression performed to obtain more extra RAM from RAM Expander.



User Atom Heap Alarm

Your PC has reached the Alarm Threshold set for the User Atom Heap gauge in the WinGauge Properties
sheet's Actions tab.

The User Atom Heap gauge displays the percentage of user atom heap usage. The user atom heap is a
resource heap located in memory that contains mostly Window titles.

If the User Atom Heap percent is high, your applications may crash. You should close some programs. If
this situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



GDI 16-bit Heap Alarm

Your PC has reached the Alarm Threshold set for the GDI 16-Bit Heap gauge in the WinGauge Properties
sheet's Actions tab.

The GDI 16-bit Heap gauge displays the percentage of GDI 16-bit heap usage. GDI is a component of
Windows that is responsible for drawing graphics on your screen or printer.

If the GDI 16-bit Heap percent is high, your applications may crash or you may be unable to finish printing
some documents. You should close some programs. If this situation persists, consider purchasing more
physical memory (RAM).

Related Topics
Understanding Windows Memory



GDI 32-bit Heap Alarm

Your PC has reached the Alarm Threshold set for the GDI 32-Bit Heap gauge in the WinGauge Properties
sheet's Actions tab.

The GDI 32-bit Heap gauge displays the percentage of GDI 32-bit heap usage. GDI is a component of
Windows that is responsible for drawing graphics on your screen or printer.

If the GDI 32-bit Heap percent is high, your applications may crash or you may be unable to finish printing
some documents. You should close some programs. If this situation persists, consider purchasing more
physical memory (RAM).

Related Topics
Understanding Windows Memory



Highest Resource Alarm

Your PC has reached the Alarm Threshold set for the Highest Resource gauge in the WinGauge
Properties sheet's Actions tab.

The Highest Resource gauge displays the percentage of highest resource usage. System resources are
managed by the GDI and User programs, so the highest resource usage can be either a GDI or User
resource, depending upon the kind of activities taking place.

If the Highest Resource percent is high, your applications may crash. You should close some programs. If
this situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



Menu Heap Alarm

Your PC has reached the Alarm Threshold set for the Menu Heap gauge in the WinGauge Properties
sheet's Actions tab.

The Menu Heap gauge displays the percentage of 32-bit menu heap usage. The 32-bit menu heap
contains information about drop-down menus.

If the Menu Heap percent is high, your applications may crash. You should close some programs. If this
situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



String Heap Alarm

Your PC has reached the Alarm Threshold set for the String Heap gauge in the WinGauge Properties
sheet's Actions tab.

The String Heap gauge displays the percentage of menu string heap usage. The menu string heap
contains text information about menu titles.

If the String Heap percent is high, your applications may crash. You should close some programs. If this
situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



Window 16-bit Heap Alarm

Your PC has reached the Alarm Threshold set for the Window 16-Bit Heap gauge in the WinGauge
Properties sheet's Actions tab.

The Window 16-bit Heap gauge displays the percentage of 16-bit user Windows Heap usage. The 16-bit
user Windows Heap contains information about windows and controls (for Windows 3.1x or 16-bit
applications).

If the Window 16-bit Heap percent is high, your applications may crash. You should close some
programs. If this situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



Window 32-bit Heap Alarm

Your PC has reached the Alarm Threshold set for the Window 32-Bit Heap gauge in the WinGauge
Properties sheet's Actions tab.

The Window 32-bit Heap gauge displays the percentage of Windows 32-bit Heap usage. The 32-bit
Windows Heap contains information about windows and controls (for Windows 95 or 32-bit applications).

If the Window 32-bit Heap Heap percent is high, your applications may crash. You should close some
programs. If this situation persists, consider purchasing more physical memory (RAM).

Related Topics
Understanding Windows Memory



Drive Space Alarm

Your PC has reached the Alarm Threshold set for the Drive Space gauge in the WinGauge Properties
sheet's Actions tab.

The Space <drive letter>: gauges display the percentage of drive space in use for each drive on your PC.
If a drive uses some kind of removable storage media, such as a 3.5-inch disk, a CD-ROM disc, or a tape
cartridge, the percentage is at zero until you insert the storage media into the drive.

If the Drive Space percent is high, you have little remaining free disk space on the corresponding drive. If
this is a hard drive, you should free up disk space by deleting files or compressing (or zipping) them. You
can do this using Nuts & Bolts' Cleanup Wizard and the Consolidate method in Disk Tune. If this doesn't

free up enough disk space for you to work with, you need to purchase another hard drive.



Drive Fragmentation Alarm

Your PC has reached the Alarm Threshold set for the Drive Fragmentation gauge in the WinGauge
Properties sheet's Actions tab.

The Fragmentation <drive letter>: gauges display the percentage of fragmentation for each drive where
you can write information.

If the Fragmentation percent for a drive is high, you should run Nuts & Bolts' Disk Tune to optimize that
disk drive to increase its performance.



Dirty Data Alarm

Your PC has reached the Alarm Threshold set for the Dirty Data gauge in the WinGauge Properties
sheet's Actions tab.

The Dirty Data gauge displays the amount of dirty data, or the number of bytes waiting to be written to the
disk. Dirty data is kept on a per cache block basis, and so a number higher than the actual number of
bytes waiting to be written may be reported.

If the Dirty Data amount is high, you should run Nuts & Bolts' Disk Tune to optimize that disk drive to
increase its performance. If the Dirty Data amount remains high, you might consider purchasing a disk
drive that offers faster disk access speeds.



Bytes Read/Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Read/Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Read/Second gauge displays the number of bytes read from the file system per second.

If the Bytes Read/Second number is low, try running Nuts & Bolts' Disk Tune to optimize that disk drive to
increase its performance.



Bytes Written/Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Written/Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Written/Second gauge displays the number of bytes written to the file system per second.

If the Bytes Written/Second number is low, try running Nuts & Bolts' Disk Tune to optimize that disk drive
to increase its performance.



Reads/Second Alarm

Your PC has reached the Alarm Threshold set for the Reads/Second gauge in the WinGauge Properties
sheet's Actions tab.

The Reads/Second gauge displays the number of read requests made to the file system per second.

If the Reads/Second number is high, applications may be frequently requesting recently used data that
Windows has removed from physical memory and placed in the swap file. You can try installing more
physical memory (RAM) to reduce the the number of read requests necessary and improve your system's
performance.



Writes/Second Alarm

Your PC has reached the Alarm Threshold set for the Writes/Second gauge in the WinGauge Properties
sheet's Actions tab.

The Writes/Second gauge displays the number of write requests made per second to the file system.

If the Writes/Second number is high, applications may be frequently obtaining recently used data that
Windows has removed from physical memory and placed in the swap file. You can try installing more
physical memory (RAM) to reduce the the number of read requests necessary and improve your system's
performance.



Allocated Memory Alarm

Your PC has reached the Alarm Threshold set for the Allocated Memory gauge in the WinGauge
Properties sheet's Actions tab.

The Allocated Memory gauge displays the number of bytes of memory allocated, or committed, in the
system. This is the total amount of memory that has been allocated in the system, across all components
and applications.

If the Allocated Memory amount is close to the total amount of physical memory in your system, Windows
will be using the swap file frequently. This will reduce the performance of your PC. You can close some
applications to free up memory and improve performance. If this situation persists, consider installing
more physical memory (RAM) in your computer.

Related Topics
Understanding Windows Memory



Maximum Disk Cache Size Alarm

Your PC has reached the Alarm Threshold set for the Maximum Disk Cache Size gauge in the WinGauge
Properties sheet's Actions tab.

(Windows 95 only.) The Maximum Disk Cache Size gauge displays the maximum size of the Windows 95
VCACHE disk cache. A disk cache is an area of RAM where recently used information is stored (in case it
is requested again soon by an application) to speed up processing.

Windows 95 determines the VCACHE disk cache size dynamically for individual files it works with. Most
likely, you won't need to change the maximum disk cache size yourself. However, you can do this by
Right-clicking My Computer and choosing the Properties command.

You can increase the maximum disk cache size, for example, if the computer is used as a network server
or if you are using a portable computer and want fewer hard disk accesses (which take more power). Or
you can decrease the maximum disk cache size if you have a desktop computer and want to more
physical memory (RAM) allocated to applications and a smaller disk cache.



Minimum Disk Cache Size Alarm

Your PC has reached the Alarm Threshold set for the Minimum Disk Cache Size gauge in the WinGauge
Properties sheet's Actions tab.

(Windows 95 only.) The Minimum Disk Cache Size gauge displays the minimum size of the Windows 95
VCACHE disk cache.

Windows 95 determines the VCACHE disk cache size dynamically for individual files it works with. Most
likely, you won't need to change the minimum disk cache size yourself. However, you can do this by
Right-clicking My Computer and choosing the Properties command.

You can increase the minimum disk cache size, for example, if the computer is used as a network server
or if you are using a portable computer and want fewer hard disk accesses (which take more power). Or
you can decrease the minimum disk cache size if you have a desktop computer and want to more
physical memory (RAM) allocated to applications and a smaller disk cache.



Disk Cache Size Alarm

Your PC has reached the Alarm Threshold set for the Disk Cache Size gauge in the WinGauge Properties
sheet's Actions tab.

(Windows 95 only.) The Disk Cache Size gauge displays the current size of the Windows 95 VCACHE
disk cache. Windows 95 uses algorithms to dynamically increase or decrease the size of the VCACHE
depending upon the situation.

Windows 95 determines the VCACHE disk cache size dynamically for individual files it works with. Most
likely, you won't need to change the disk cache size yourself. However, you can do this by Right-clicking
My Computer and choosing the Properties command.

You can increase the disk cache size, for example, if the computer is used as a network server or if you

are using a portable computer and want fewer hard disk accesses (which take more power). Or you can
decrease the disk cache size if you have a desktop computer and want to more physical memory (RAM)
allocated to applications and a smaller disk cache.



Swap File Defective Alarm

(Windows 95 only.) Your PC has reached the Alarm Threshold set for the Swap File Defective gauge in
the WinGauge Properties sheet's Actions tab.

The Swap File Defective gauge displays the number of bytes in the swap file found to be physically
defective on the system hard drive where the swap file resides. The system hard drive is the drive that
contains your Windows folder.

Windows allocates swap file space in 4K frames, so a single damaged sector causes the entire frame to
be marked defective.

If the Swap File Defective gauge displays anything except zero bytes, you should save your work and
close all open programs. Then run Nuts & Bolts' Disk Minder with the Check Entire Disk Surface for Read
Errors check box selected. Disk Minder can map out bad sectors so that they will not be used in the future
for storing your valuable data.



Swap File in Use Alarm

Your PC has reached the Alarm Threshold set for the Swap File in Use gauge in the WinGauge
Properties sheet's Actions tab.

The Swap File in Use gauge displays the amount of the swap file that is currently in use in bytes.

You can compare this amount to the amount shown in the Swap File Size gauge. If the Swap File in Use
size is close to the Swap File size amount and you are using Windows 3.1x, you can increase the size of
the swap file. If you are using Windows 95, you probably won't need to change the size of the swap file.
Windows 95 dynamically increases the size of the swap file when needed, as long as there is available
disk space on the Windows system drive (or the drive that contains the swap file).



Swap File Size Alarm

Your PC has reached the Alarm Threshold set for the Swap File Size gauge in the WinGauge Properties
sheet's Actions tab.

The Swap File Size gauge displays the total size of the swap file in bytes.

You can compare this amount to the amount shown in the Swap File in Use gauge. If the Swap File in
Use size is close to the Swap File size amount and you are using Windows 3.1x, you can increase the
size of the swap file. If you are using Windows 95, you probably won't need to change the size of the
swap file. Windows 95 dynamically increases the size of the swap file when needed, as long as there is
available disk space on the Windows system drive (or the drive that contains the swap file).



Discards Alarm

Your PC has reached the Alarm Threshold set for the Discards gauge in the WinGauge Properties sheet's
Actions tab.

The Discards gauge displays the number of page discards per second. Pages are segments of
information that Windows moves between RAM and the swap file on the system hard drive.

If the number of page discards is high, you may want to install more physical memory (RAM) on your
computer to reduce the need to move data to the swap file and improve the performance of your system.



Page-Outs Alarm

Your PC has reached the Alarm Threshold set for the Page-Outs gauge in the WinGauge Properties
sheet's Actions tab.

The Page-Outs gauge displays the number of page-out operations per second. Paging out is the process
Windows uses to save information in RAM out to the hard disk so it can reassign that RAM to a different
linear address.

If the number of page outs is high, you may want to install more physical memory (RAM) on your
computer to reduce the need to move data to and from the swap file and improve the performance of your
system.



Page-Ins Alarm

Your PC has reached the Alarm Threshold set for the Page-Ins gauge in the WinGauge Properties sheet's
Actions tab.

The Page-Ins gauge displays the number of page-in operations per second. Paging in is the process
Windows uses to read information from the hard disk into RAM.

If the number of page ins is high, you may want to install more physical memory (RAM) on your computer
to reduce the need to move data to and from the swap file and improve the performance of your system.



Instance Faults Alarm

Your PC has reached the Alarm Threshold set for the Instance Faults gauge in the WinGauge Properties
sheet's Actions tab.

The Instance Faults gauge displays the frequency at which instance fault data is being modified as the
number of instance faults taken per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Page Faults Alarm

Your PC has reached the Alarm Threshold set for the Page Faults gauge in the WinGauge Properties
sheet's Actions tab.

The Page Faults gauge displays the number of page faults taken per second. A page fault happens each
time an application accesses reserved but empty linear memory, or an instanced (localized) part of global
memory.

If the Page Faults number is greater than zero, you should save your work and close open programs.
Then restart your computer. If the Page Faults number continues to be greater than zero, run Disk Minder
to diagnose and repair any disk errors. If the situation persists, you may need to reinstall the application
that is producing the page faults, or even reinstall Windows.



Other Memory Alarm

Your PC has reached the Alarm Threshold set for the Other Memory gauge in the WinGauge Properties
sheet's Actions tab.

The Other Memory gauge displays the number of bytes of memory allocated that are not stored in the
swap file. Examples of other memory include disk cache pages, memory allocated fixed (non-pageable),
and memory-mapped files.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.

Related Topics
Understanding Windows Memory



Swappable Memory Alarm

Your PC has reached the Alarm Threshold set for the Swappable Memory gauge in the WinGauge
Properties sheet's Actions tab.

The Swappable Memory gauge displays the number of bytes of memory allocated from the swap file.
Swap file pages that are locked still count as swappable in calculating this value.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.

Related Topics
Understanding Windows Memory



Locked Memory Alarm

Your PC has reached the Alarm Threshold set for the Locked Memory gauge in the WinGauge Properties
sheet's Actions tab.

The Locked Memory gauge displays the amount of RAM that is allocated by Windows to applications
which is locked by those applications.

If the Locked Memory percentage gets very high it will slow down your system because Windows is
working harder than it needs to and less virtual memory is available. If an application is causing this
situation, you can close the application. However, if a driver is causing this problem, you need to find
which driver is responsible.

Related Topics
Understanding Windows Memory



Free Memory Alarm

Your PC has reached the Alarm Threshold set for the Free Memory gauge in the WinGauge Properties
sheet's Actions tab.

The Free Memory gauge displays the amount of RAM that is free, or available for use.

If the Free Memory amount is low, you should close some open programs. If the situation persists, you
should install more physical memory (RAM).

Related Topics
Understanding Windows Memory



Processor Usage (%) Alarm

Your PC has reached the Alarm Threshold set for the Processor Usage (%) gauge in the WinGauge
Properties sheet's Actions tab.

The Percentage Usage (%) gauge displays the percent of your PC's CPU (central processing unit) time
that is busy (or not spent idle). This value is approximate.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Virtual Machines Alarm

Your PC has reached the Alarm Threshold set for the Virtual Machines gauge in the WinGauge Properties
sheet's Actions tab.

The Virtual Machines gauge displays the number of virtual machines present in the system. A virtual
machine, such as the Windows System VM or a virtual DOS machine, is software that emulates all the
capabilities of a PC for an application.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Threads Alarm

Your PC has reached the Alarm Threshold set for the Threads gauge in the WinGauge Properties sheet's
Actions tab.

The Threads gauge displays the number of processor threads present in the system. A thread is part of a
process (or task) performed by an application. Depending upon how the application is designed, a thread
could be printing a document, recalculating values, or sorting information.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Number of Open Files Alarm

Your PC has reached the Alarm Threshold set for the Number of Open Files gauge in the WinGauge
Properties sheet's Actions tab.

The Number of Open Files gauge displays the number of open files on the network.
By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Number of Resources Alarm

Your PC has reached the Alarm Threshold set for the Number of Resources gauge in the WinGauge
Properties sheet's Actions tab.

The Number of Resources gauge displays the number of resources.
By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.

Related Topics
Understanding Windows Memory



Number of Sessions Alarm

Your PC has reached the Alarm Threshold set for the Number of Sessions gauge in the WinGauge
Properties sheet's Actions tab.

The Number of Sessions gauge displays the number of sessions.
By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Number of Networks Alarm

Your PC has reached the Alarm Threshold set for the Number of Networks gauge in the WinGauge
Properties sheet's Actions tab.

The Number of Networks gauge displays the number of networks running.
By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Written Per Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Written Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Written Per Second gauge displays the number of bytes written to the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Read Per Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Read Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Read Per Second gauge displays the number of bytes read from the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Transactions Per Second Alarm

Your PC has reached the Alarm Threshold set for the Transactions Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Transactions Per Second gauge displays the number of SMB transactions per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Receive Gap Alarm

Your PC has reached the Alarm Threshold set for the Receive Gap gauge in the WinGauge Properties
sheet's Actions tab.

The Receive Gap gauge displays the burst receive gap time, or interpacket gap for incoming burst traffic,
in microseconds.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Send Gap Alarm

Your PC has reached the Alarm Threshold set for the Send Gap gauge in the WinGauge Properties
sheet's Actions tab.

The Send Gap gauge displays the burst send gap time, or interpacket gap for out-going burst traffic, in
microseconds.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Requests Pending Alarm

Your PC has reached the Alarm Threshold set for the Requests Pending gauge in the WinGauge
Properties sheet's Actions tab.

The Requests Pending gauge displays the number of requests waiting to be processed by the network
server.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Dropped Burst Alarm

Your PC has reached the Alarm Threshold set for the Dropped Burst gauge in the WinGauge Properties
sheet's Actions tab.

The Dropped Burst gauge displays the number of burst packets dropped (the number of burst protocol
packets lost in transit).

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Dropped NCP Alarm

Your PC has reached the Alarm Threshold set for the Dropped NCP gauge in the WinGauge Properties
sheet's Actions tab.

The Dropped NCP gauge displays the number of CP packets dropped (the number of regular NCP
packets lost in transit).

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Dirty Bytes Cached Alarm

Your PC has reached the Alarm Threshold set for the Dirty Bytes Cached gauge in the WinGauge
Properties sheet's Actions tab.

The Dirty Bytes Cached gauge displays the amount of dirty data in bytes that is currently stored in the
disk cache by the redirector and waiting to be written.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes in Cache Alarm

Your PC has reached the Alarm Threshold set for the Bytes in Cache gauge in the WinGauge Properties
sheet's Actions tab.

The Bytes in Cache gauge displays the amount of data in bytes that is currently cached by the redirector.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Written Per Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Written Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Written Per Second gauge displays the number of bytes written to the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Read Per Second Alarm

Your PC has reached the Alarm Threshold set for the Bytes Read Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Bytes Read Per Second gauge displays the number of bytes read from the redirector per second.

The redirector is the program that makes remote network drives appear as local drives so that your PC
can access them.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Transactions Per Second Alarm

Your PC has reached the Alarm Threshold set for the Transactions Per Second gauge in the WinGauge
Properties sheet's Actions tab.

The Transactions Per Second gauge displays the number of SMB transactions per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Throughput Alarm

Your PC has reached the Alarm Threshold set for the Throughput gauge in the WinGauge Properties
sheet's Actions tab.

The Throughput gauge displays the total of disk reads and writes in bytes per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Writes Alarm

Your PC has reached the Alarm Threshold set for the Writes gauge in the WinGauge Properties sheet's
Actions tab.

The Bytes Written Per Second gauge displays the disk writes in bytes per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Alarm

Your PC has reached the Alarm Threshold set for the Bytes gauge in the WinGauge Properties sheet's
Actions tab.

The Bytes Read Per Second gauge displays the disk reads in bytes per second.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Threads Alarm

Your PC has reached the Alarm Threshold set for the Threads gauge in the WinGauge Properties sheet's
Actions tab.

The Threads gauge displays the number of server threads, which are Windows threads used by the
server.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



NBs Alarm

Your PC has reached the Alarm Threshold set for the NBs gauge in the WinGauge Properties sheet's
Actions tab.

The Network Buffers gauge displays the number of server network buffers.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Buffers Alarm

Your PC has reached the Alarm Threshold set for the Buffers gauge in the WinGauge Properties sheet's
Actions tab.

The Buffers gauge displays the number of server working buffers.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Bytes Alarm

Your PC has reached the Alarm Threshold set for the Bytes gauge in the WinGauge Properties sheet's
Actions tab.

The Bytes gauge displays the amount of memory used by the server in bytes.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Battery Power Alarm

Your PC has reached the Alarm Threshold set for the Battery Threshold gauge in the WinGauge
Properties sheet's Actions tab.

The Battery Power gauge displays the amount of battery power remaining in your portable PC.

If this number is low, you will need to switch to a power adapter or another battery pack soon.



Cache Hits Alarm

Your PC has reached the Alarm Threshold set for the Cache Hits gauge in the WinGauge Properties

sheet's Actions tab.

The Cache Hits gauge displays the ratio of requests that were made to disk to the requests that were
found in the cache, or vice versa. The higher this number the better because more data is in memory
where it is quickly available to applications.

If the number is very low, your cache is not being effective and you should try modifying the VCACHE
parameters.



GDI Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the GDI Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The GDI Heap Without Hurricane gauge displays the percentage of GDI heap usage if you were not using
the Heap Expander provided with Helix Software's Hurricane software. GDI is a component of Windows
that is responsible for drawing graphics on your screen or printer. The GDI heap is a resource heap for
keeping pens, brushes, fonts, and other information for handling graphics when you're running
applications.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Window Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the Window Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The Window Heap Without Hurricane gauge displays the percentage of user Windows Heap usage if you
were not using the Heap Expander provided with Helix Software's Hurricane software. The user Windows
Heap contains information about windows and controls.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Menu Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the Menu Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The Menu Heap Without Hurricane gauge displays the percentage of menu heap usage if you were not
using the Heap Expander provided with Helix Software's Hurricane software. The menu heap contains
information about drop-down menus.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



String Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the String Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The String Heap Without Hurricane gauge displays the percentage of menu string heap usage if you were
not using the Heap Expander provided with Helix Software's Hurricane software. The menu string heap
contains text information about menu titles.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Atom Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the Atom Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The Atom Heap Without Hurricane gauge displays the percentage of user atom heap usage if you were
not using the Heap Expander provided with Helix Software's Hurricane software. The user atom heap is a
resource heap located in memory that contains mostly Window titles.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



GDI Atom Heap Without Hurricane Alarm

Your PC has reached the Alarm Threshold set for the GDI Atom Heap Without Hurricane gauge in the
WinGauge Properties sheet's Actions tab.

The GDI Atom Heap Without Hurricane gauge displays the percentage of GDI atom heap usage if you
were not using the Heap Expander provided with Helix Software's Hurricane software. The GDI atom
heap is a resource heap located in memory that contains font related information including font names.

By default, the alarm for this gauge is turned off. This alarm gauge has no recommended solution.



Ping Alarm

Your PC has reached the Alarm Threshold set for the Ping gauge in the WinGauge Properties sheet's
Actions tab.

The Ping gauge displays the results of a Ping test you've set up to determine whether your connection to
a host on the Internet is working properly. Ping is a program that sends an Internet Control Message
Protocol (ICMP) echo packet to an Internet host you specify. Ping reports the amount of time the
response took in milliseconds.



URL Minder Alarm

Your PC has reached the Alarm Threshold set for the URL Minder gauge in the WinGauge Properties
sheet's Actions tab.

This URL address has changed (the file has either been updated or removed from the host computer)
since the last time it was queried.



Registry Performance Data Alarms
The Registry Performance Data alarms are for extensible, system specific gauges.

By default, the alarms for these gauges are turned off and have no recommended solution.



Address Space

The sum total of all possible memory addresses available at a given time. This is 4 GB (gigabytes) on a
386 or later PC in protected mode.



Launch Pad

The Launch Pad is a window where you can place application and document icons so you can
conveniently access them.



Benchmarks

A benchmark is a standardized task that tests various devices for measurements, such as speed.



BIOS

The BIOS (or Basic Input/Output System) contains buffers for sending information from an application to
the hardware device, such as a printer, where the information should go.



Buffers

A buffer is a temporary storage location for information being sent or received.



Bytes

A byte is eight bits of information composed of zeros and ones, one of which may be a parity bit. Most
character sets, such as ASCII, use one byte to represent each character (letter, number, or special

symbol).



Cache

A cache is part of the computers memory used to temporarily store recently accessed information. A
cache is designed on the premise that recently used information may be needed again soon. Keeping
information available in cache reduces the time it takes for an application to obtain the information again.



Cluster

A cluster is a unit of storage allocation usually consisting of four or more 512-byte sectors.



Conventional Memory

Conventional memory is the first 640 K (kilobytes) of RAM (random access memory).



CPU (Central Processing Unit)

The brain of your computer. This is main computer chip that controls all activity that takes place on a
computer.



Diagnostics

Diagnostics are tests run to detect faults in a computer system. Diagnostics tests are run to detect faults
before they become serious problems so the faults can be corrected.



Directories

Directories are locations within a volume on a drive where you can store files or subdirectories. In
Windows 95, directories are equivalent to folders that appear on the desktop in a drive window.



Discardable Memory

Discardable memory is memory used by an application that it has marked as discardable. Windows can
reallocate the discardable memory to a different application if it needs to.



DLLs (Dynamic Link Libraries)

A DLL is an executable code module that can be loaded on demand and linked at run time. DLLs can be
shared among multiple applications and independently updated, transparent to the applications. DLLs can
also be unloaded when they are no longer needed.



DMA (Direct Memory Access)

DMA is a fast method of moving information from a storage device or LAN interface card directly to RAM
which speeds processing time. DMA is direct memory access by a peripheral device that by-passes the
CPU to save time.



Expanded Memory

DOS running on the Intel 80286, 80386, or 80486 family of computers can only address one megabyte of
memory at one time. Expanded memory is the memory located between the base memory (either 512 K
or 640 K) and one megabyte. Expanded memory is reserved by DOS for housekeeping tasks, such as
managing information that appears on the screen.



Extended Memory

Memory above one megabyte in 80286 and higher PCs. Extended memory can be used for RAM disks,
disk caches, or Windows, but it requires the CPU to run in a special mode (protected mode or virtual real

mode).



FAT (File Allocation Table)

The FAT is a roadmap, or index, that points to the location where all the information in files is stored on a
floppy disk or hard drive. The FAT is extremely important because the system uses it to store and retrieve
files containing information.

When you save a file in Windows, it is stored in multiple pieces (in clusters made up of multiple sectors)
on the disk. Windows also saves the roadmap, or index, that points to these clusters in two copies of the
FAT (File Allocation Table). The FAT contains the directions to all the pieces of your files, so that
applications can find them again later.



GDT (General Description Table)

The GDT is a table that is basic to the operation of protected mode. This table contains data structures
(descriptors) that describe various regions of memory and how they may be accessed. Windows uses the
GDT for system devices. See LDT.



Global Heap

The Global Heap is the general pool of memory available to Windows applications.



GPF (General Protection Fault)

An error condition caused by an application when it attempts to perform an operation not allowed by the
operating system. Windows uses GPFs to determine and control the state of the currently executing
application. GPFs that are unexpected by Windows cause a system error message to appear.



HMA (High Memory Area)

The HMA is the first 64 K of extended memory. If you use DOS 5.0, you can save memory by loading
DOS into the HMA. Do this by adding the DOS=HIGH setting to your CONFIG.SYS file and restarting

your PC.



Interrupt

A temporary suspension of a process caused by an event outside that process. More specifically, an
interrupt is a signal or call to a specific routine. Interrupts allow peripheral devices, such as printers or
modems, to send a call to the CPU requesting attention.



1/0 (Input/Output) Device

An I/O device is any piece of computer hardware that can exchange information with the CPU. Examples
of 1/0 devices include network cards, printers, speakers or other sound devices, or devices connected to
the serial or parallel ports of your PC such as external modemes.



Kernel

The Kernel is the part of a computer operating system that performs basic functions such as switching
between tasks.



LDT (Local Descriptor Table)

The LDT is a secondary data structure table that contains additional information about various regions of
memory and how they can be accessed. Windows uses the LDT for programs.



Linear Memory

Linear memory is the currently defined address space of the system that Windows uses to allocate
memory to Windows applications.



Local Heap

The Local Heap is a region of memory allocated for local use by an application.



Locked Memory

Locked memory is memory used by an application that cannot be relocated or discarded by Windows.



Mapping

Mapping is the process of assigning physical memory (RAM) to a particular linear address range.



Mode Switch

A mode switch is a transition made by the CPU when changing from one mode of operation to another.
For example, switching from real or protected mode, or a transition between different levels of protection.

SeeRing 0, 1, 2, 3.



Modules

A module is a device driver loaded by Windows.



Paging

The process of saving information stored in RAM to the swap file on the system hard drive so Windows
can make the RAM available at a different linear address.



Parallel Port

The parallel port is a connector on the back of your PC and on some peripheral devices. With the
appropriate driver software installed and a parallel cable connected to the parallel ports on your PC and a
peripheral device, the two can communicate with each other. Parallel transmissions have no EIA
standard, but most equipment follows a quasi-standard called the Centronics Parallel Standard.



PCI (Peripheral Component Interconnect) Bus

The PCI Bus is a local motherboard specification (that provides connector slots on the motherboard for
installing peripheral cards). The PCI Bus, designed by Intel, offers a high performance, peripheral
component level interface to the CPU bus.



Physical Memory

Physical memory is the RAM (Random Access Memory) installed in your PC. See Random Access

Memory (RAM).



Protected Mode

A mode of operation of 80286 or later CPUs which allows access to more than 1 MB of memory.



RAM (Random Access Memory)

RAM (Random Access Memory) is also called physical memory. It is installed in your PC on SIMMs
(Single Inline Memory Modules) or DIMMs (Dual Inline Memory Modules). RAM is volatile, extremely
high-speed storage used by your computer for processing information.



Real Mode

A mode of 80286 or later CPUs, where the CPU operates substantially like an older 8086 CPU and can
address directly only 1 MB of memory.



Resources

Resources are objects that Windows and its applications can use, such as the buttons on the screen that
you can click.



Ring 0,1,2,3

Different levels of protection in protected mode, where programs having varying degrees of freedom of
operation. Ring 0 (zero) is least protected and has direct access to all hardware in the system.



Sector

A sector is a pie-shaped portion of a hard disk. A disk is divided into tracks and sectors. Tracks are
complete circuits and are divided into sectors. Under DOS, a sector is 512 bytes.



Serial Port

A serial port is an input/output port (connector) that allows the transmission of information out at one bit at
a time, as opposed to parallel which transmits eight bits, or one byte at a time.



Swap File

The swap file is created by Windows on the system hard disk. It uses the swap file to copy information
stored in part of the linear address space so it can reallocate the RAM used at that location to another
linear address space.



Swapping

Swapping is the process of saving to disk or restoring from disk the contents of RAM so that the RAM can
be used elsewhere in linear memory.



System Resources

System resources are a series of data structures kept by Windows. System resources are managed by
the Windows User and GDI programs and maintain information about objects that appear on your screen.
For instance, for each button on your screen the User program has to know where it is supposed to be
located, what program owns it, and which part of the program needs to be notified when you click the
button. GDI must maintain information about pens used to draw lines on screen, fonts used to draw
characters, and so on.

The information about the various objects managed by the User and GDI programs is kept in six 64K
regions of memory known as resource heaps. These regions are actually 64K local heaps. These regions
are 64K because 64K is the maximum size a 16-bit program can deal with efficiently. User and GDI are
16-bit programs because Windows was originally designed to run on the Intel 8088 and 80286, 16-bit
processors.

The User Resource Heaps are divided into:

The Window Heap, which contains information on windows and controls
The Menu Heap, which contains information on drop-down menus

The Menu String Heap, which contains the text messages that appear in the menus

The User Atom Heap, which contains mostly Window titles
The GDI Resource Heaps are:

The main GDI Resource Heap, which contains pens, brushes, fonts and various other information
related to displaying Graphics

The GDI Atom Heap, which contains some font related information including font names.

The GDI and User Atom Heaps are usually discounted because the information in them is subsidiary to
the other Local Resource Heaps. So, the other Heaps would always fill up before the Atom Heaps. The
same is still true if Hurricane's Heap Expander (another Helix Software product) is loaded, although all the
Heaps have been greatly expanded (now you understand the "Heap Expander" name too).



32BDA (32-Bit Disk Access)

32BDA is a process in Windows where the device driver that accesses the disk runs entirely as a 32-bit
program at Ring 0 (zero).



32BFA (32-Bit File Access)

32BFAis a process in Windows where the DOS file operations are controlled by a program, or set of
devices, that operate entirely as 32-bit programs at Ring 0 (zero).



Unlocked Memory

Unlocked memory is physical memory that Windows can copy to the swap file on disk, and whose linear
address can be changed whenever Windows chooses.



UMB (Upper Memory Block)

The UMB is the area in memory between 640 K and 1 MB that have RAM mapped into them by memory
managers, such as Helixs Netroom or MemMaker. See Expanded memory.




V86 Mode (Virtual 8086 Mode)

V86 mode is a mode of operation of 80386 or later CPUs where programs, originally designed to run in
real mode, can run as sub-programs to a protected mode control program or operating system.



Video Memory

Video memory, called VRAM, is physical memory installed on your PCs video card that is used for
displaying information on the screen.



Virtual Memory

Virtual memory is the amount of memory that exists either as physical memory (RAM) or on the hard drive
(in the swap file). When a part of memory that is located in the swap file is accessed by an application,
Windows reads the information into RAM.



VMs (Virtual Machines)

Virtual machines (also called Virtual DOS machines or VDMs) are created in Windows 95 when you open
a MS-DOS Prompt window. The VDM is a software emulation of a separate computer, offering all the
services that the DOS application expects of a PC.



VxDs (Virtual Device Drivers)

VxDs are used in Windows 95 to communicate with all physical hardware in the system. This prevents
any application from having direct access to a piece of hardware. Instead, it communicates only through
the VxD for that hardware.



Windows 95 Registry

The Windows 95 Registry file contains user, application, and computer-specific configuration information
in a central location that was kept in various .INI files in Windows 3.1. The Registry contains settings that
determine how your computer runs.



Hidden Files

A hidden file is any file that does not show up in a regular directory listing. Typically, hidden files have one
of the following file extensions:

DLL-(Dynamic Link Library)

SYS-System file

VXD-Virtual Device Driver

386-Virtual Device Driver

DRV-Device Driver
In Windows, a programmer can set any file with the hidden file attribute.

Tip In Windows Explorer or My Computer, you can select to show or hide hidden files. To do this,
choose the Options command from the View menu, click the View tab, select the Show or the
Hide radio button, and click OK.



System Files

A system file is a file used exclusively by the operating system, or Windows.






